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Fabric Manager Client

Cisco Fabric Manager Client is a java-based GUI application that provides access to the Fabric Manager 
applications from a remote workstation.

This chapter contains the following sections:

• About Fabric Manager Client, page 5-1

• Launching Fabric Manager Client in Cisco SAN-OS Release 3.2(1) and Later, page 5-2

• Fabric Manager Client Quick Tour, page 5-6

• Setting Fabric Manager Preferences, page 5-18

• Network Fabric Discovery, page 5-19

• Modifying the Device Grouping, page 5-20

• Controlling Administrator Access with Users and Roles, page 5-21

• Using Fabric Manager Wizards, page 5-21

• Fabric Manager Troubleshooting Tools, page 5-22

About Fabric Manager Client
Cisco Fabric Manager is a Java and SNMP-based network fabric and device management tool with a GUI 
that displays real-time views of your network fabric, including Cisco MDS 9000 Family and third-party 
switches, hosts, and storage devices.

In addition to complete configuration and status monitoring capabilities for Cisco MDS 9000 Family 
switches, Fabric Manager Client provides Fibre Channel troubleshooting tools. These health and 
configuration analysis tools use the MDS 9000 switch capabilities including Fibre Channel ping and 
traceroute.

Note You must use the same release of Fabric Manager Client and Fabric Manager Server.
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Fabric Manager Advanced Mode
Advanced mode is enabled by default and provides the full suite of Fabric Manager features, including 
security, IVR, iSCSI, and FICON. Uncheck the Advanced check box in the upper right corner of the 
Fabric Manager Client to simplify the user interface. In this mode, you can access basic MDS 9000 
features such as VSANs, zoning, and configuring interfaces. 

Launching Fabric Manager Client in Cisco SAN-OS Release 
3.2(1) and Later

Note As of Cisco SAN-OS Release 3.2(1), the Fabric Manager Client login procedure has changed. If you are 
running a version of Cisco SAN-OS that is earlier than Cisco SAN-OS 3.2(1), follow the login 
instructions in the “Setting the Seed Switch in Cisco SAN-OS Releases 3.1(1) to 3.2(1)” section on 
page A-1 or the “Setting the Seed Switch in Releases Prior to Cisco SAN-OS Release 3.1(1)” section on 
page A-3.

Note Network administrators must initially launch Fabric Manager Client using Fabric Manager Web Server, 
as described below. Once an administrator has installed the Fabric Manager Client icon on your desktop, 
you can double click on the icon to launch the Fabric Manager Client.

To launch Fabric Manager Client, follow these steps:

Step 1 Open your browser and enter the IP address where you installed Fabric Manager Server, or enter 
localhost if you installed Fabric Manager Server on your local workstation. 

You see the Fabric Manager Web Server Login dialog box shown in Figure 5-1.

Figure 5-1 Fabric Manager Web Server Login Dialog Box
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Step 2 Enter your user name and password and click Login.

You see the Fabric Manager Web Server Summary page.

Step 3 Click the Download link in the upper right corner of the page.

You see the Download page for Fabric Manager and Device Manager (see Figure 5-2).

Figure 5-2 Download Page for Fabric Manager and Device Manager

Step 4 Click the link for either Fabric Manager or Device Manager.

If you are launching Fabric Manager Client for the first time, you see a message asking whether you want 
to create shortcuts for Fabric Manager (see Figure 5-3).

Figure 5-3 Fabric Manager Create Shortcut(s) Message

Step 5 Click Yes to create shortcuts for Fabric Manager.

Note This message only appears the first time you launch Fabric Manager Client.
5-3
Cisco MDS 9000 Family Fabric Manager Configuration Guide

OL-8007-10, Cisco MDS SAN-OS Release 3.x



Send  documenta t ion  comments  to  mdsfeedback -doc@c i sco .com

Chapter 5      Fabric Manager Client
Launching Fabric Manager Client in Cisco SAN-OS Release 3.2(1) and Later
Step 6 When the software is installed and icons are created on your desktop, double-click the Fabric Manager 
icon to launch Fabric Manager.

You see the Fabric Manager Login dialog box shown in Figure 5-4.

Figure 5-4 Fabric Manager Login Dialog Box

Step 7 Enter the Fabric Manager Server user name and password.

Step 8 Check the Use SNMP Proxy check box if you want Fabric Manager Client to communicate with Fabric 
Manager Server through a TCP-based proxy server.

Step 9 Click Login. Once you successfully log in to Fabric Manager Server, you can set the seed switch and 
open the fabrics that you are entitled to access.

Note When you launch Fabric Manager Client for the first time or when there are no available fabrics, 
you see the Discover New Fabric dialog box.

You see the Discover New Fabric dialog box shown in Figure 5-5.

Figure 5-5 Discover New Fabric Dialog Box

Note Only network administrators can discover new fabrics.

Step 10 Set the fabric seed switch to the Cisco MDS 9000 Family switch that you want Fabric Manager to use.

Step 11 Enter the user name and password for the switch.
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Step 12 Choose the Auth-Privacy option according to the privacy protocol you have configured on your switch:

a. If you have not configured the switch with a privacy protocol, then choose Auth-Privacy option MD5 
(no privacy). 

b. If you have configured the switch with your privacy protocol, please choose your Auth-Privacy 
choice.

Note If you want a clean discovery, remove the fabric and rediscover it.

Step 13 Click Discover.

You see the Control Panel dialog box shown in Figure 5-6.

Figure 5-6 Control Panel Dialog Box

Note You see a message in the dialog box when the server and client are running on the same 
workstation and there are unlicensed fabrics in the database. You also see a message when there 
are unmanaged fabrics (the state of the licenses is unknown).

Step 14 Check the check box(es) next to the fabric(s) you want to open in the Select column, or click Discover 
to add a new fabric.

Note Only network administrators can continuously manage or unmanage fabrics. For more 
information, see the “Selecting a Fabric to Manage Continuously” section on page 3-4.

Step 15 Click Open to open the selected fabric(s).

Note If you have an incomplete view of your fabric, rediscover the fabric with a user that has no 
VSAN restriction.

To launch Fabric Manager Client from within a running instance of Fabric Manager, follow these steps:

Step 1 Choose File > Open Fabric or click the Open Switch Fabric icon on the Fabric Manager toolbar. 

You see the Control Panel dialog box (see Figure 5-6).

Step 2 Check the check box(es) next to the fabric(s) you want to open in the Select column and click Open. 
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Note Changes made using Fabric Manager are applied to the running configuration of the switches 
that you are managing. If you have made changes to the configuration or performed an operation 
(such as activating zones), Fabric Manager prompts you to save your changes before you exit.

Fabric Manager Client Quick Tour
This section describes the Fabric Manager Client interface shown in Figure 5-7.

Figure 5-7 Fabric Manager Main Window

1 Menu bar—Provides access to options that are organized by menus.

2 Toolbar—Provides icons for direct access to the most commonly used options on the File, Tools, 
and Help menus.

3 Information pane—Displays information about whatever option is selected in the menu tree.
5-6
Cisco MDS 9000 Family Fabric Manager Configuration Guide

OL-8007-10, Cisco MDS SAN-OS Release 3.x



Send  documenta t ion  comments  to  mdsfeedback -doc@c i sco .com

Chapter 5      Fabric Manager Client
Fabric Manager Client Quick Tour
Note You can resize each pane by dragging the boundaries between each region or by clicking the Minimize 
or Maximize controls.

Menu Bar
The menu bar at the top of the Fabric Manager main window provides options for managing and 
troubleshooting the current fabric and for controlling the display of information on the Fabric pane. The 
menu bar provides the following menus:

• File—Opens a new fabric, rediscovers the current fabric, locates switches, sets preferences, prints 
the map, and clears (right-click on log) or exports the Fabric pane log.

• View—Changes the appearance of the map (these options are duplicated on the Fabric pane toolbar).

• Zone—Manages zones, zone sets, and inter-VSAN routing (IVR).

• Tools—Verifies and troubleshoots connectivity and configuration., as described in the “Fabric 
Manager Troubleshooting Tools” section on page 5-22.

• Performance—Runs and configures Performance Manager and Cisco Traffic Analyzer, and 
generates reports.

• Server—Runs administrative tasks on clients and fabrics. Provides Fabric Manager Server 
management and a purge command. Lists switches being managed.

• Help—Displays online help topics for specific dialog boxes in the Information pane.

4 Status Bar (right side)—Shows the last entry displayed by the discovery process and the possible 
error message.

5 Fabric pane—Displays a map of the network fabric, including switches, hosts, and storage. It also 
provides tabs for displaying log and event data.

6 Status Bar (left side)—Shows short-term transient messages, such as the number of rows 
displayed in a table.

7 Logical Domains pane—Displays a tree of configured SAN, fabrics, VSANs, and zones, and 
provides access to user-defined groups.

8 Physical Attributes pane—Displays a tree of available configuration tasks depending on the 
fabric, VSAN, or zone selected previously. Lists the switches and end devices in the logical 
selection.
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Toolbar
The Fabric Manager main toolbar provides icons for accessing the most commonly used menu bar 
options as shown in Table 5-1.

Table 5-1 Fabric Manager Client Main Toolbar

Icon Description

Opens switch fabric.

Rediscovers current fabric.

Finds in the map.

Creates VSAN.

Launches DPVM wizard.

Edits full zone database.

Launches IVR zone wizard.

Launches PortChannel wizard.

Launches FCIP wizard.

Launches iSCSI wizard.

Launches QoS wizard.

Configures users and roles.
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Logical Domains Pane
Use the Logical Domains pane to manage attributes for fabrics, VSANs, and zones, and to access 
user-defined groups. Right-click one of the folders in the tree and click a menu item from the pop-up 
menu. You see the appropriate configuration dialog box.

The default name for the fabric is the name, IP address, or WWN for the principal switch in VSAN 1. If 
VSAN 1 is segmented, the default name is chosen from a principal switch with the smallest WWN. In 
order, the fabric names you may see are as follows:

• Fabric <sysName>

• Fabric <ipAddress>

• Fabric <sWWN>

To change the fabric name using Fabric Manager, follow these steps:

Step 1 Choose Server > Admin.

You see the Control Panel dialog box.

Step 2 Double click the fabric name and enter the new name of the fabric.

Launches IP-ACL wizard.

Launches License Install wizard.

Launches Software Install wizard.

Performs switch health analysis.

Performs fabric configuration analysis.

Performs end-to-end connectivity analysis.

Monitors ISL performance. Brings up real-time 
ISL performance information for all interfaces in 
the fabric, in the Information pane.

Shows online help.

Table 5-1 Fabric Manager Client Main Toolbar (continued)

Icon Description
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Step 3 Click Apply to change the name.

Filtering

Fabric Manager has a filtering mechanism that displays only the data that you are interested in. To filter, 
first select the fabric and VSAN from the Logical Domains pane. This action narrows the scope of what 
is displayed in the Fabric pane. Any information that does not belong to the selected items is dimmed. 
Also, any information that does not belong to the selected items is not displayed in the tables in the 
Information pane. As shown in Figure 5-8, the filter that you select is displayed at the top right of the 
Fabric Manager window.

To further narrow the scope, select attributes from the Physical Attributes pane. The Fabric Manager 
table, display, and filter criteria change accordingly.

Physical Attributes Pane
Use the Physical Attributes pane to display a tree of the options available for managing the switches in 
the currently selected fabric, VSAN, or zone.

To select an option, click a folder to display the options available and then click the option. You see the 
table with information for the selected option in the Information pane. The Physical Attributes pane 
provides the following main folders:

• Switches—Views and configures hardware, system, licensing, and configuration files.

• Interfaces—Views and configures FC physical, FC logical, Ethernet, SVC, and PortChannel 
interfaces.

• FC Services—Views and configures Fibre Channel network configurations.

• IP—Views and configures IP storage and IP services.

• Events—Views and configures events, alarms, thresholds, notifications, and informs.

• Security—Views and configures MDS management and FC-SP security.

• ISLs—Views and configures Inter-Switch Links.

• End Devices—Views and configures end devices.

Information Pane
Use the Information pane to display tables of information associated with the option selected from the 
menu tree in the Logical Domains or Physical Attributes panes. The Information pane toolbar provides 
buttons for performing one or more of the operations shown in Table 5-2.
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Note After making changes, you must save the configuration or the changes will be lost when the device is 
restarted. 

Note The buttons that appear on the toolbar vary according to the option that you select. They are activated or 
deactivated (dimmed) according to the field or other object that you select in the Information pane.

Table 5-2 Information Pane Toolbar

Icon Description

Apply Changes Applies configuration changes.

Refresh Values Refreshes table values.

Create Row Opens the appropriate dialog box to make a new 
row in the table.

Delete Row Deletes the currently highlighted rows from the 
table.

Copy/Ctrl+C Copies data from one row to another.

Paste/Ctrl +V Pastes the data from one row to another.

Undo Changes/Ctrl-Z Undoes the most recent change.

Export Exports and saves information to a file.

Print Table Prints the contents of the Information pane.

Detach Table Displays a non-editable copy of the table in the 
Information pane in its own window, which you 
can move around the screen.
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Detachable Tables

Detachable tables in Fabric Manager let you detach tables and move them to different areas on your 
desktop so that you can compare similar tables from different VSANs. You can keep informational tables 
open from one view while you examine a different area in Fabric Manager. To detach tables, click the 
Detach Table icon in the Information pane in Fabric Manager.

Fabric Pane
Use the Fabric pane to display the graphical representation of your fabric. Table 5-3 explains the 
graphics you may see displayed, depending on which devices you have in your fabric.

Table 5-3 Fabric Manager Graphics

Icon or Graphic Description

Director class MDS 9000.

Non-director class MDS 9000.

Generic Fibre Channel switch.

Cisco SN5428.

An orange line through a device indicates that the 
device is manageable but there are operational 
problems.

An orange X through a device or link indicates 
that the device or ISL is not working properly.

A red line through a device indicates that the 
device is not manageable.

A red X through a device or link indicates that the 
device is down or that the ISL is down.

Fibre Channel HBA (or enclosure).

Fibre Channel target (or enclosure).

iSAN
5-12
Cisco MDS 9000 Family Fabric Manager Configuration Guide

OL-8007-10, Cisco MDS SAN-OS Release 3.x



Send  documenta t ion  comments  to  mdsfeedback -doc@c i sco .com

Chapter 5      Fabric Manager Client
Fabric Manager Client Quick Tour
If a switch or director is grayed out, Fabric Manager can no longer communicate with it.

The bottom of the Fabric pane has the following tabs:

• Fabric—When displaying multiple fabrics, each fabric has its own tab. You can switch between 
fabrics by clicking on their respective tabs.

• Log—Displays messages that describe Fabric Manager operations, such as fabric discovery.

• Events—Displays information about the SNMP traps received by the management station. This 
includes combination events as detected by discovery and important traps like license, SNMP, and 
FICON.

When viewing large fabrics in the Fabric pane, it is helpful to do the following tasks:

• Turn off end device labels

• Collapse loops

• Collapse expanded multiple links (collapsed multiple links are shown as very thick single lines)

• Dim or hide portions of your fabric by VSAN

iSCSI host.

Fibre Channel ISL and edge connection.

Fibre Channel PortChannel.

IP ISL and edge connection.

IP PortChannel.

Fibre Channel loop (storage).

IP cloud (hosts). This icon is also used to represent 
a fabric when viewing a SAN (multiple fabrics) in 
the Fabric Manager Fabric pane.

Any device, cloud, or loop with a box around it 
means that there are hidden links attached.

Table 5-3 Fabric Manager Graphics (continued)

Icon or Graphic Description

99
50

9

Terminal
blocks

1

2

3

4
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Note When a VSAN, zone, or zone member is selected in the VSAN tree, the map highlighting changes to 
identify the selected objects. To remove this highlighting, click the Clear Highlight button on the Fabric 
pane toolbar or choose Clear Highlight from the pop-up menu.

Context Menus

When you right-click an icon in the Fabric pane, you see a pop-up menu with options that vary depending 
on the type of icon selected. The various options available for different objects include the following:

• Open an instance of Device Manager for the selected switch.

• Open a CLI session for the selected switch.

• Copy the display name of the selected object.

• Execute a ping or traceroute command for the device.

• Show or hide end devices.

• View attributes.

• Quiesce and disable members for PortChannels.

• Set the trunking mode for an ISL.

• Create or add to a PortChannel for selected ISLs.

The Fabric pane has its own toolbar with options for saving, printing, and changing the appearance of 
the map. When you right-click the map, a pop-up menu appears that provides options (duplicated on the 
toolbar) for changing the appearance of the map.

Note You can launch web-based or non-web-based applications from the Fabric pane. To do this, you assign 
an IP address to the storage port or enclosure. Then right-click to bring up the pop-up menu, and select 
Device Manager.

Saving the Map

You can save the map in the Fabric Pane as an image, or as an editable Visio diagram. You can save the 
map with or without labels on the links. The created Visio diagram is editable and saved in two layers:

• The default layer includes all switches and links in the fabric.

• The end devices layer includes the end devices and can be turned off to remove end devices from 
the Visio diagram.

To save the map as a Visio diagram, select Files > Export > Visio and choose Map or Map with link 
labels. The saved Visio diagram retains the viewing options that you selected from the Fabric pane. For 
example, if you collapse multiple links in the map and export the links as a Visio diagram, the Visio 
diagram shows those multiple links as one solid link.

The Show Tech Support option from the Tools menu also supports saving the map as a Visio diagram.
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Purging Down Elements

The Fabric pane allows you to refresh the map at any time by clicking the Refresh Map icon. The 
Refresh Map icon redraws the map but does not purge elements that are down. To purge down elements 
you can:

• Click Server > Purge Down Elements. This purges all down elements in the fabric.

• Right-click the Fabric pane and select Purge Down Elements.

• Right-click a down element and select Purge. This action purges only this element from the fabric.

Note If you select an element that is not down and purge it, that element will reappear on the next 
fabric discovery cycle.

Multiple Fabric Display

Fabric Manager can display multiple fabrics in the same pane (see Figure 5-8).

Figure 5-8 Fabric Manager’s Multiple Fabric Display Window
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Note The same user name and password must be used to log into multiple fabrics.

The information for both fabrics is displayed; you do not need to select a seed switch. To see details of 
a fabric, select the tab for that fabric at the bottom of the Fabric pane, or double-click the Cloud icon for 
the fabric in the SAN tab.

Note Enclosure names should be unique. If the same enclosure name is used for each port, Fabric Manager 
shows a host/target enclosure connected to both fabrics. To fix this problem, you can either disable 
auto-creation or create unique enclosure names.

Filtering by Groups

You can filter the Fabric pane display by creating groups of switches or end ports. To create a group in 
Fabric Manager, follow these steps:

Step 1 Right-click a switch or end port in the Fabric pane map and select Group > Create. 

You see the Edit User Defined Group dialog box shown in Figure 5-9. 

Figure 5-9 Edit User Defined Group Dialog Box

Step 2 Enter a group name in the Name field. 

1 The Fabric view tab for fabric 172.23.46.152. When selected, the Fabric view displays fabric 
172.23.46.152.

2 The Fabric view tab for fabric 172.23.46.153. When selected, the Fabric view displays fabric 
172.23.46.153.

3 SAN tab (selected), showing two fabrics.
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Step 3 Use the arrows to move additional switches or end ports from the Available column to the Selected 
column.

Step 4 Click OK to save the group.

To add a switch or end port to an existing group in Fabric Manager, follow these steps:

Step 1 Right-click a switch or end device and select Group > Add To > YourGroupName. 

You see the Edit User Defined Group dialog box (see Figure 5-9).

Step 2 Use the arrows to move additional switches or end ports from the Available column to the Selected 
column.

Step 3 Click OK to save the updated group.

To filter the display by a group you have created, follow these steps:

Step 1 Expand the Groups folder in the Logical Domains pane. 

You see the list of groups that you have created as shown in Figure 5-10.

Figure 5-10 Group Highlighted in Fabric Pane Map

Step 2 Click the name of the group that you want to filter.

In the Fabric pane, the switches or end devices in your group are shown normally; all other switches and 
end devices are shown in gray.

Step 3 Click the Groups folder in the Logical Domains pane to return the display to normal.

Note User defined groups tables are filtered based on switches in the group except for switches where 
CFS-controlled features are enabled when all CFS member switches are displayed to avoid 
misconfigurations.
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Status Bar
The status bar at the bottom of the Fabric Manager window shows the last entry displayed by the 
discovery process, and the possible error message on the right side. The status bar displays a message 
stating that something has changed in the fabric and a new discovery is needed. The status bar shows 
both short-term, transient messages (such as the number of rows displayed in the table) and long-term 
discovery issues.

Setting Fabric Manager Preferences
To set your preferences for the behavior of the Fabric Manager, choose File > Preferences from the 
Fabric Manager menu bar. You see the Preferences dialog box with the following tabs for setting 
different components of the application:

• General

• SNMP

• Map

The default General preferences for Fabric Manager are as follows:

• Show Device Name by—Displays the switches in the Fabric pane by IP address, DNS name, or 
logical name. The default setting for this value is Logical Name.

• Show WorldWideName (WWN) Vendor—Displays the world wide name vendor name in any table 
or listing displayed by Fabric Manager. Check the Prepend Name check box to display the name in 
front of the IP address of the switch. Check the Replacing Vendor Bytes check box to display the 
name instead of the IP address. The default is the Prepend Name option.

• Show End Device Using—Displays end devices in the Fabric pane using alias or pWWN alias. The 
default setting for this value is Alias.

• Show Shortened iSCSI Names—Displays the default setting for this value is OFF.

• Show Timestamps as Date/Time—Displays timestamps in the date/time format. If this preference is 
not checked, timestamps are displayed as elapsed time. The default setting is enabled (checked).

• Telnet Path—Displays the path for the telnet.exe file on your system. The default is telnet.exe, but 
you need to browse for the correct location.

Note If you browse for a path or enter a path and you have a space in the pathname (for example, 
c:\program files\telnet.exe), then the path will not work. To get the path to work, you must 
manually place quotes around it (for example, "c:\program files\telnet.exe").

• Use Secure Shell instead of Telnet—Specifies whether to use SSH or Telnet when using the CLI to 
communicate with the switch. If enabled, you must specify the path to your SSH application. The 
default setting is disabled.

• Confirm Deletion—Displays a confirmation pop-up window when you delete part of your 
configuration using Fabric Manager. The default setting is enabled (checked).

• Export Tables with Format—Specifies the type of file that is created when you export a table using 
Device Manager. The options are tab-delimited or XML. The default setting is Tab-Delimited.

• Show CFS Warnings—Shows warning messages if CFS is not enabled on all switches for a selected 
feature.
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The default SNMP preferences for Fabric Manager are as follows:

• Retry request 1 time(s) after 5 sec timeout—You can set the retry value to 0-5, and the timeout value 
to 3-30.

• Trace SNMP packets in Log—The default setting for this value is OFF.

• Enable Audible Alert when Event Received—The default setting for this value is OFF.

The default Map preferences for Fabric Manager are as follows:

• Display Unselected VSAN Members—Displays the unselected VSAN members in the Fabric pane. 
The default setting for this value is ON.

• Display End Devices—Displays the fabric’s end devices in the Fabric pane. The default setting for 
this value is ON.

• Display End Device Labels—Displays the fabric’s end device labels in the Fabric pane. The default 
setting for this value is ON.

• Expand Loops—Displays the loops in the fabric as individual connections in the Fabric pane. The 
default setting for this value is OFF.

• Expand Multiple Links—Displays multiple links in the Fabric pane as separate lines instead of one 
thick line. The default setting for this value is ON.

• Open New Device Manager Each Time—Opens a new instance of Device Manager each time that 
you invoke it from a switch in your fabric. The default value is OFF, which means that only one 
instance of Device Manager is open at a time.

• Select Switch or Link from Table—Allows you to select a switch or link in the Fabric pane by 
clicking the switch or link in a table in the Information pane. The default setting for this value is 
disabled (unchecked), which means clicking a switch or link in the table does not change the switch 
or link selection in the Fabric pane.

• Layout New Devices Automatically—Automatically places new devices in the Fabric pane in an 
optimal configuration. The default setting for this value is OFF. In this mode, when you add a new 
device, you must manually reposition it if the initial position does not suit your needs.

• Use Quick Layout when Switch has 30 or more End Devices—Displays the default setting for this 
value (30). You can enter any number in this field. Enter 0 to disable Quick Layout.

• Override Preferences for Non-default Layout—Displays the default setting for this value (ON).

• Automatically Save Layout—If this option is enabled, any changes in the layout are automatically 
saved. The default setting for this value is ON. 

• Detach Overview Window—Allows you to easily center the Fabric pane on the area of the fabric 
that you want to see. (This feature is useful for large fabrics that cannot be displayed entirely within 
the Fabric pane.) Bring up the overview window by clicking the Show/Hide Overview Window 
button. It overlays the fabric window and remains there until you click the Show/Hide Overview 
Window button again. If you enable this preference, you can detach the overview window and move 
it to one side while you access the Fabric pane. The default setting for this value is disabled 
(unchecked).

Network Fabric Discovery
Cisco Fabric Manager collects information about the fabric topology through SNMP queries to the 
switches that are connected to Fabric Manager. The switch replies after having discovered all devices 
connected to the fabric by using the information from its FSPF technology database and the Name Server 
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database and collected using the Fabric Configuration Server’s request/response mechanisms that are 
defined by the FC-GS-3/4 standard. When you start Fabric Manager, you enter the IP address (or host 
name) of a seed switch for discovery.

After you start Fabric Manager and the discovery completes, Fabric Manager presents you with a view 
of your network fabric, including all discovered switches, hosts, and storage devices.

Modifying the Device Grouping
Because not all devices are capable of responding to FC-GS-3 requests, different ports of a single server 
or storage subsystem may be displayed as individual end devices on the Fabric Manager map.

To group end devices in a single enclosure to have them represented by a single icon on the map, Fabric 
Manager, follow these steps:

Step 1 Expand End Devices and then select Storage or Hosts in the Physical Attributes pane.

You see the end devices displayed in the Information pane.

Step 2 Click one of the devices in the Fabric pane, or click the Enclosures tab of the Information pane, then 
click the device name (in the Name field) you want to include in the enclosure.

Step 3 Enter a name to identify the new enclosure in the Fabric pane map.

Step 4 Click once on the device name in the Name field. To select more than one name, press the Shift key and 
click each of the other names.

Step 5 Press Ctrl-C to copy the selected name(s).

Step 6 Press Ctrl-V to paste the device name into the Name field.

Note To remove devices from an enclosure, triple click the device name and press Delete. To remove 
an enclosure, repeat this step for each device in the enclosure.

Using Alias Names as Enclosures
To create an enclosure that uses the alias name as the name of the enclosure using Fabric Manager, follow 
these steps:

Step 1 Expand End Devices and select Hosts or Storage from the Physical Attributes pane. 

You see the list of devices in the Information pane. The NxPorts tab is the default.

Step 2 Right-click the enclosure names that you want to convert to alias names and select Alias > Enclosure as 
shown in Figure 5-11.
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Figure 5-11 Alias Enclosure

Step 3 Click the Apply Changes icon to save these changes. 

Controlling Administrator Access with Users and Roles
Cisco MDS 9000 Family switches support role-based management access whether using the CLI or 
Cisco Fabric Manager. This lets you assign specific management privileges to particular roles and then 
assign one or more users to each role.

The default-role contains the access permissions needed by a user to access the GUI (Fabric Manager 
and Device Manager). These access permissions are automatically granted to all users in order for them 
to use the GUI.

Cisco Fabric Manager uses SNMPv3 to establish role-based management access. After completing the 
setup routine, a single role, user name, and password are established. The role assigned to this user 
allows the highest level of privileges, which includes creating users and roles. Use the Cisco Fabric 
Manager to create roles and users and to assign passwords as required for secure management access in 
your network.

Using Fabric Manager Wizards
Fabric Manager Client provides the following wizards to facilitate common configuration tasks:

• VSAN—Creates VSANs on multiple switches in the fabric and sets VSAN attributes including 
interop mode, load balancing, and FICON.

• Zone Edit Tool—Creates zone sets, zones, and aliases. Adds members to zones and edits the zone 
database.

• IVR Zone—Creates IVR zone sets, zones, and aliases. Enables IVR NAT and auto-topology. Adds 
members to IVR zones, and edits the IVR zone database.

• PortChannel—Creates PortChannels from selected ISLs either manually or automatically. Sets 
PortChannel attributes such as channel ID and trunking mode. 

• FCIP—Creates FCIP links between Gigabit Ethernet ports. Enables Fibre Channel write 
acceleration and IP compression.
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• DPVM—Establishes dynamic port VSAN membership, enables autolearning, and activates the 
DPVM database.

• iSCSI—Creates zones for iSCSI initiators and adds a VSAN to a target-allowed VSAN list. 

• QoS—Sets QoS attributes for zones in the selected VSAN. 

• IP ACL—Creates ordered IP access control lists and distributes to selected switches in the fabric.

• License Install—Facilitates download and installation of licenses in selected switches in the fabric.

• Software Install—Verifies image compatibility and installs software images on selected switches in 
the fabric.

Fabric Manager Troubleshooting Tools
Fabric Manager has several troubleshooting tools available from the toolbar or Tools menu. Procedures 
for using these tools are described in Chapter 66, “Troubleshooting Your Fabric.” This section provides 
a brief description of each tool:

• Zone Merge Analysis—The zone merge analysis tool (available from the Zone menu) enables you 
to determine if zones will merge successfully when two Cisco MDS switches are interconnected. If 
the interconnected switch ports allow VSANs with identical names or contain zones with identical 
names, then Fabric Manager verifies that the zones contain identical members. The merge analysis 
tool can be run before attempting a merge or after fabrics are interconnected to determine zone 
merge failure causes.

• End-to-End Connectivity—Fabric Manager’s end-to-end connectivity analysis tool uses FC Ping to 
verify interconnections between Cisco MDS switches and end-device (HBAs and storage devices) 
in a particular VSAN. In addition to basic connectivity, Fabric Manager can optionally verify the 
following:

– Paths are redundant.

– Zones contain at least two members.

End devices are connected to a manageable switch (have a currently active in-band or out-of-band 
management path.)

• Switch Health Analysis—You can run an in-depth switch health analysis with Fabric Manager. It 
verifies the status of all critical Cisco MDS switches, modules, ports, and Fibre Channel services. 
Over 40 conditions are checked. This tool provides a very fast, simple, and thorough way to assess 
Cisco MDS switch health.

• Fabric Configuration Analysis—Fabric Manager includes a fabric configuration analysis tool. It 
compares the configurations of all Cisco MDS switches in a fabric to a reference switch or a policy 
file. You can define what functions to check and what type of checks to perform. The analysis can 
look for mismatched values, and missing or extra values. If all configuration checking is performed 
for all functions, over 200 checks are performed for each Cisco MDS switch.

After the analysis is run, the results are displayed with details about the issues that were discovered. You 
can automatically resolve configuration differences by selecting them and clicking the Resolve button. 
Fabric Manager automatically changes the configuration to match the reference switch or policy file.
5-22
Cisco MDS 9000 Family Fabric Manager Configuration Guide

OL-8007-10, Cisco MDS SAN-OS Release 3.x


	Fabric Manager Client
	About Fabric Manager Client
	Fabric Manager Advanced Mode

	Launching Fabric Manager Client in Cisco SAN-OS Release 3.2(1) and Later
	Fabric Manager Client Quick Tour
	Menu Bar
	Toolbar
	Logical Domains Pane
	Filtering

	Physical Attributes Pane
	Information Pane
	Detachable Tables

	Fabric Pane
	Context Menus
	Saving the Map
	Purging Down Elements
	Multiple Fabric Display
	Filtering by Groups

	Status Bar

	Setting Fabric Manager Preferences
	Network Fabric Discovery
	Modifying the Device Grouping
	Using Alias Names as Enclosures

	Controlling Administrator Access with Users and Roles
	Using Fabric Manager Wizards
	Fabric Manager Troubleshooting Tools



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /FRA <>
    /ENU (Use these settings to create PDF documents with higher image resolution for improved printing quality. The PDF documents can be opened with Acrobat and Reader 5.0 and later.)
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308000200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e30593002537052376642306e753b8cea3092670059279650306b4fdd306430533068304c3067304d307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e30593002>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


